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General information for IT placement test

e The IT placement test duration is 2 hours.

e No student is allowed to leave the exam before 1 hour.

e The IT placement test is divided into 3 parts:
1) Part|—IT Basic Knowledge & Internet (Theory) (20 Questions)
2) Part Il —=Windows 7 & MS Word (Practical) (25 Questions)

3) Part lll = PowerPoint, Excel, and Animation (Practical) (25 Questions)

e Passing Criteria in IT Placement Test:
1) Part|—IT Basic Knowledge & Internet (Theory) (609%0)
2) Part Il = Windows 7 & MS Word (Practical)  (70%)

3) Part Il — PowerPoint, Excel, and Animation (Practical)  (70%)

e General Information:

e A candidate who scores min 60% in Part |, min 70% in Part Il, and
min 70% in Part Il will be exempted from IT in the FP.

e A candidate who scores min 60% in Part |, min 70% in Part Il, and
fails to get min 70% in Part 11l will be exempted from Level 1 IT in
the FP.

e A candidate who scores min 70% in each Part Il and Part Il but
fails to get min 60% in Part I, will be considered for exemption from
IT in the FP.
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Basic IT concepts

il glaal) L of 3SE1 dpila) asaliall

Basic IT Concepts

Cila glral) Lin ol 3SH Al analial)
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Definition of Computer:
e A computer is an electronic device,

e It operates under the control of instructions (software)
stored in its own memory unit,

e |t can accept data (input),manipulate data (process),
and produce information (output)

1]l iy o
(Y Slea sa il e

o 5 (el ) Claddel ool e sl Slea dany 0
lead) 5,803

5 (DY) Ala ye) bl JUEialy SiguaSll Jlen sty o
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() AY s 50)

Computers can perform four general operations, which
comprise the information processing cycle:

‘u\.a_,u\:\i\a.q'&)}dsauﬁj&hhc tlJL\)j_’.LtAS” JL@Ae}g:\
L LS el o

1. Input Jaayidde 1
2. Process dalledl e 2
3. Output gAY Ale 3
4. Storage i
g A dlee 4
Data: el

It is a collection of raw facts, figures and symbols, such as
numbers, words, images, video and sound, given to the
computer during the input phase.

Data in this phase not organized, meaningful and useful.

¢ pea «AlalS ¢ sa )l ‘FGJ‘J\J&@}\J\ Al (e A gana
J\AJY\-U;)A‘_‘JA)S}M\ )LPQJL@L;J\?QQ}A\))%_\:\B

Blbe e g dageda gt g Aaliia e Als pall oda 8 UL S

Information:
It is data that is organized, meaningful, and useful.

During the output Phase, the information that has been
created is put into some form, such as a printed report.

sila plaall
oWJaA}@M}MLAAQ_\LJQ.\gA
s o da Atuall clashaall (585 | Ay Al je JBA

3o 5 e A g S e glaa S5 ol de gulan )85 Jie JIS2I
el en 4203 o

Characters of Computers:

e Reliability.

e High Speed.

e Accuracy.

e Mass Storage of information

e Communication with other computers through network
like Internet.

iRl e

Loyl o
idadlie o
clall S8 e
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Primary Components of a Computer:
e Input devices.

e Central Processing Unit (CPU)

e  Memory.

e Output devices.

e  Storage devices.

s Ssmas) jlgad Al aliall
Jaylsieal o

LS dalladl s o

3 S o

ZIAY il e

A 3 eal @

Input devices:

Hardware device to send data to computer. Examples are
Keyboard and Mouse

JAN) 85

5 il G ) e el Sl ) il Jls 555 34
5 )\l
.0

CPU - Central Processing Unit:

It is the brain of the computer

Ay 38 al) Aallaal) Bas g

O 8 st G Clalall man e J gl Jind) ey
Fsmasl)

RAM - Random Access Memory:

(Temporary Memory) is the main memory of the computer.
Any information stored in RAM is lost when the computer is
turned off.

-l gial) JAY) 3813

3 SIAN a3 e LS i gnaeSll el i N 5 SIA yia
aie 385 5 S0 o3 8 Al e sleall aan (Y Gl 5 ABga

Dl @38
ROM - Read Only Memory: :hadd 5o Al 5,813
It has start-up directions for your computer. It is permanent | s’ LS ¢ sai gl gali o canaii s leal) Jasnis 3 SIA o3a o
memory. . Aaila 5_SIA s3a
Output devices: I AY i)
Hardware device to get output from computer. Example AaLa s dalall Jie i snaaSl) (e e slaal) 215300l o 585 5 el
includes Printer and screen ismasll

Storage Devices:

Auxiliary storage devices are used to store data when they
are not being used in memory. The most common types of
auxiliary storage used on personal computers are floppy
disks, hard disks and CD-ROM drives

:CRAIN B gl

58I 8 aadind W Ladie <l sheall 5 bl (g % o 585 5 gl
Aaead) &l gany) caliall a3l ¢y yall (a8l Jia

Floppy Disks:

It is an external storage device which store 144 MB.

10l e A

o) L bl 38 585 ) daa A g 53580 5 s
bl 1,44 Jasi dabine

Hard Disk:

Another form of auxiliary storage is a hard disk. Storage
capacities of hard disks for personal computers range from
10 GB to 250 GB (one billion bytes are called a gigabyte).

1elall Ga Al

I R PYIVAN | PENFR EN R ENP YRR YR i S PEY &\}Hi aal
Culilasa 250 Leb 0330 dalise

CD - Compact Disk: Aaadall al AN
It is used as storage device. It stores up to 650 MB ) L bl o 3a% a8 A daa Ja) 0 58300 5 jead ) 53l aal
Sublaas 650
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DVD - Digital Versatile disk:

It is another form of storage device. It can store up to 17
GB.

ot Al Lpa Hall 0 333 3 jea) g1l aal asmiall B0 a8
blas 17 ) dead dabie ) cliball o530

BIT- Binary digit. It is either 0 or 1

A 50 Jie Sl A8 e

BYTE — 8 Bits make 1 byte.

8 st Sl 1 SIAN Gl Bas 5 1y

KB — Kilo Byte.1KB =1024 bytes

b 1024 s s 1<l glis

MB — Mega Byte. 1MB = 1024 KB

b shS 1024 (6 sbs 1 ubilaga

GB — Giga Byte. 1 GB = 1024 MB

Sblaae 1024 sk (bl

TB —Tera Byte. 1 TB = 1024 GB

Gulilana 1024 (s sbon 1l s

Hardware:

Physical parts of the computer such as screen, mouse,
keyboard, speakers, microphone, printer, and camera.

STEB Al

4A_9S ‘BJ\A}\ IR d’.’m‘)ﬁ_,:\.\.aﬂ\ )L@AL@_\AU}S:\:\‘?:\MQ‘)PY‘
_\):\ASJ\ cAJu\L” 60_95_5‘)5:3.«!\ e ladd) sc.ﬁl.i.d\

Software:

Programs or instructions written to make functioning of the
computer.

1S i g
el Sam Gy o 8 1 ladedl )

GUI - Graphical User Interface:

It allow the user to deal with mouse and other functions in
the operating system. Example : MS Windows

A gaa ) padiecal) dgal g
b gas s 5Ske Jie 5L aladinly sl ae Jaladil pasioall i
BSTLT

Operating System:

It is to perform the functions of loading, storing and
executing an application and how to transfer data. For
example: Win95, Win 98, Win 2000, Win Millennium, Win
XP and Win Vista.

s Jaadl) eLBS

2ol gl (e de sane gy e Jead Al Al el pll e ey
D9t g Jie Aidaill eal yog 58 seSll a JS Jee 408 203 )
98 511 <2000 sy 2 sS) 505 98 Hsans 95
L an g

Application Software:

It consists of programs that tell a computer how to produce
information. Some of the more commonly used packages
are:

e Word Processing (MS Word)
e Electronic Spreadsheet (MS Excel)
e Database (MS Access)

e Presentation Graphics (MS PowerPoint)

Aghlal) gl sl

ot Jlaxiud) Al gl ) (e e sleal) 35 3 el Ll 0
(D35 s Sis) (o paill Zllae o

(OnS) s Se) i) Jsha o

(oS gy Sla) L 26 @

(e sh g g Sa) il g sall @

VIRUS:

Computer program that cause loss of data or computer
malfunction.

roug
sl Slea Jadaat s Ll g biiay oy el
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Ergonomics:

A study on work environment. It is essential to maintain a
good work environment while using computer

dgasal) Jead) iy

sl Sl aladinl 8 daall Jeal) B Al 3 Lo o

Network :

The word network can be used to describe a very large and
complicated set of equipment. In its most accurate and
simplest definition a network refers to the cables and
electronic components that amplify the signals going
through the cables.

LAl

lgatany o Alaia 55 0aSll 3 gl (40 Ae gama (o0 B ke (o
L Lad i) Ji) UL 5 Slas) A 0 dina S

Mainframe computer:

It handles typically huge databases, and can perform
complex mathematical operations. We find them mainly in
industry, research, and university computing centers.

(i) ) (@laad) S gaaasl)

Clileall pran o sty 5 Clibal) ac) 8 e Alila DS (A0 & 6
Aelically Clas¥) b aadin LS stiaall dylual

Minicomputer:

It can support a smaller number of simultaneous users,
typically 50 to 100. These machines are primarily used by
larger businesses to handle accounting, billing, and
inventory records.

s gial) 5 gaadl)
Daeal s bl Jia b Sl &y sl Ciluall 8 adiioyg
LAY AL sy il sl

Microcomputer (Personal Computer or PC): (et S gast)
A type of computer. It is commonly used in offices or small g el il pall 5 CailSall (Jlall A Slead) 18 aadiiny
business. ) 3ol
Laptop Computer: rdgaaadl i gasast)

It is also known as Note book computer. It runs on battery.

L_A,Jr_a;\;ﬁ;\;&;}\d@.uﬁ\)w&_,ﬁ_ﬂg&\ﬁ)ﬁ\&\;ﬂ Aa)
lebs 3 () daad Bl g 4y sy

Computer Network (Server):

Connection between computers.

pdlad) AaY g5 gaaS

A b saSl 3 gl Gn Jhai¥) e aeluy

Software Piracy:

The unauthorized copying of software.

b ) dla B

e b eyl el i Bglae

Shareware:

It use a program regularly to pay a registration fee to the
program's author directly.

A jidial) Sy )

8a3ne e ) B oume 3y ¢ adl) s e Blaa g 555 ol
Nealaiily il 3) Lt Mo aaiioaall e iy

Freeware: free programs.

Asilae (o) SR (o 8 sl gl Apilaal) e )
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Internet

(Apallal) ASull) i i)

Internet Concepts

(Foallal] A1) 3 ) ablia
(frad Bl ) o2 )

Internet :

Connecting computers across the globe. A huge
network of computers.

s )

S A5 4 el e Cosulall 3 jeal by 5 S5 s

hypertext transfer protocol

WWW s A g ALAN o) sie
World Wide Web o gl A i)l 330
http: : http Jsssisn

Gl il & J S 535 2

Domain name for websites:

Naming conventions of websites depend on its
purpose

.gov — government

s en gl cpglin! slacdl) Jlaa

40355 A el e bl pall 538 Apandi Maing

A program to send and receive mails

.edu - education L;AJS“A: gov
.com- commercial wl=d 1 edu
.om — oman website @i com
.aero — airlines Jke ;' om
.org - organization etc. o ek Lsha s gero

albier  org
Email : 1S A &

A A b I i) 5 Jla )Y padion zali

Inbox :

A concept used in Email where the mails are kept

Tl Ggdia

(33 gl bl agd Jadas A Sl Je Ju o gede g8

Compose mail :

This is used to write a new mail

. J.\L»AS\ X J,\-“

anaadl Al S 3l 138 kg

CC:

Carbon copy. It is used in email.

:@ﬁﬂ\@\

o AY i Al )l (e A o

BCC:

Blank carbon copy. It is used in email.

relias Ayigy S Add

jad Bl 48 e (93 aAY Jed ALl (e das o
Al Gyl LY
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Address book :

This is used in email accounts to store the emalil
address and information of friends.

1Cpgbial) b

Search Engine :

A program used to search for information or web
pages.

URL :

Uniform Resource Locator. It is the place where the
web address is typed.

réand) & jaa
u“}um}\uuw\usﬁuﬂedaﬁug @AU).} 9
:‘,auéméy

sl dadia o sie 48 S A S

Common email websites :

e  www.mail.yahoo.com — yahoo mail

¢ www.gmail.com - Google mail
¢ www.hotmail.com - Hotmail

:Mm\gigﬂﬁ“ﬂ 3l bl ga Ciladia

AL e e
dasmnnadse o
e disp ypade o

Commonly used websites :

www.yahoo.com — yahoo.com

:a\.\ﬁu\ﬂaﬁwﬁjél‘pajua

° Ll -

e www.google.com — Google search J:A ) 8?‘ :

e  www.du.edu.om — Dhofar university R m cfj‘

e www.squ.edu.om- Sultan Qaboos university . .k Axals e o

e www.rop.gov.om — Royal Oman police s Olabudl) Andlas gge
website Agblal) glee Aoyl aBse o

e www.dm.gov.om —Dhofar municipality Db inh e e

e www.mohe.gov.om- Ministry of Higher COke Bl adaill 355 a0
Education.

e www.omanair.aero —Oman air
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Windows 7

28) 5il) dyaa

1) 531 Ayana
Windows 7 Concepts (Radl 43l ) ax sia)

The Desktop: : isall mha

e The main area of the Windows 7 is called R . G -
Desktop in which all the programs and other Gh“t e 7 Ml fman gub\(\ cf.ai‘ o
important shortcuts are available. a5 el ol gan 4 el s S

csnlal 8 53 Ragall el Ll

e |t has a start menu from where most of the

programs can be accessed. a0 LA e g M AE e ssing e
o)l alane
e It has a status bar which gives information on Goms s ALY Jlan e Liad g giass e

the various programs run. sl b el 2 g e

Start Menu: fag) " daild
A user can start any programs or applications from Tl s ekt of meels w el 3 dedioall aukd
Start menu. It has also links to My Computer, My | .. . o < )id PO N .
33l " golea " 3L L Cla g Liayl LA (e a5
Documents etc. ! gt
N T Cab]
Customizing the Desktop : Sl e Ao Jaael)

e Changing the wall paper — Background of the
desktop.

e Changing the screen saver- Automatically Sl b Gla - Bl ) 2 S e

started when the computer is left in no use

for a longer time. O3 Gomlall & Lavie Ldall A0LE JSE jas @

Al e Uslia 4l da 3aal alaaial

e Changing the Screen Resolution and Color
Quality Vs B3 gn g Aalal Auksl) KU s
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Adjusting Time and Date :

Setting the time and date in the computer.

-

Tuesday, January 25, 2011

4 January, 2011 4 AT
Su Mo Tu We Th Fr Sa [/~ -\
%6 27 28 29 30 31 1 | |
2 3 4 5 6 7 8 |T - =}
9 10 11 12 13 14 15 .
16 17 18 19 20 21 22

. . Y 4
73 M{FEI6 277 8 29 \‘L 1o
A1 2 3 4 5 —

1:22:40 PM

Change date and time settings...

g ly gl b

o JMA (e opadlall b g il 5 i gl Joaes (S
REE A

Adjusting the Volume of the System:

Click on the Volume button available in the
status bar of the desktop and on clicking the
following screen will appear.

Adjust the volume by moving the tab with the
help of mouse.

Volume can be muted by selecting the check
box “Mute All” available in the windows.

L)

Mixer

T Gl (g giua i

AL T &l ety i) el

e\&ubhﬂ\ﬂgﬁd%wﬁg\%\ °
_BJ'\

S LA SR A (e Cigeall 5K (Kar e
LA i 2 g pall " Lasen o gaal

Creating Shortcuts:

Right click the mouse on the desktop
Choose New -> Shortcut and the following
window appears

Browse the computer files to locate the
desired application/file for which the shortcut
need to be created

Follow the wizard by pressing next until the
end of the wizard

T clilall g gal ) @Bla g eLL)

b e saga g o G sl 5 e ) e
.

"ala " dae Sl A (e RS "aaa" A1 e
s Al AsLE) el jelain

Gl ikl s k)l adge e jlea By @
e Alay L s of

a5 e baraally allaall Cllagdat 05l @
- el il shad Al
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Creating Folders :

Intel(R) TV Wizard

Folder New 3

Shortcut

B Screen resolution

Microsoft Office Access 2007 Database
Bitmap image
Contact

i) Microsoft Office PowerPoint Presentation
H]  Microsoft Office Publisher Document
® WinRARarchive

)] Microsoft Office Excel Worksheet

@ WinRARZP archive

B Briefcase

e Right Click the mouse button on the desktop,
the following screen will appear

. Click on the new Folder

. A new folder will be created. Type the name
as you wish for the new folder.

Other operations with folders

e Rename folder
e Delete Folder
e Delete folder

e Copy folder

e Cutfolder

e Paste folder.

s Glalaal) gLl

) s e gy a8l 5 e &) e
- ALa LA ol el

Alase yial dpe 6l D) e oS s e ) e

S 8 ¢ Sl mhans e ais alae oL s @
cuaal) el 13gd e 5 3 )

s Glaladl Ao ladan (Ko a0 clilee

Anall and s @
Aaall Cads @
Aaall Cads @

Al Gai e
Alaall 28 @
Asal Bual @

File management in Windows 7 :

The same set of operations can be done with the file
which is creating files, renaming files, deleting files
and copying files as with folders.

D7 Sshg ddan & cililal) 31

PS\ASJA@A&S}‘RAAQS&‘Q&AP&‘M‘J&AG&!

Cclaladl e Gl
File Extension Application Name - — - -
os o 2y ) el o Gl S5y o)
Xls MS Excel 2099 e n .doc
.ppt MS Powerpoint JoS) Aana p Xls
.mdb MS Access S Jsb Fman ppt
.bmp MS Paint oanS) dana .mdb
.pdf Adobe Acorbat Reader ala )l Ay .bmp
Axt Notepad il ST dgaa pdf
3 )Sdall dama g Axt
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My Computer :

This folder gives easy to files and folders in the any
computer

:ll ij A llsﬁu

Clalad) ) A s Jaad o sl 138 DA (e (R
Csela Slea sl 8 A A claladl

Windows Explorer :

This program helps in locating the files and it helps to
organize the files and folders in a computer.

s 300 o) ChdiSia

il aalai IS g L ) el ualiall 138 seloy
Gagalall 8 353 claladl

Searching Files, Folders and Pictures:
Windows 7 offers a powerful feature of searching files

and folders.

The program to search can be started from the Start
Menu. When the search program is started the
following screen appears.

«f_#) Enipaing Tocl

o .-': Pan:

‘fv Femcte Desdtop Connection
o

‘.'.-'}"ﬂ Wirdows Mawand Scan

i PS5 Vizwer

*  oll'regrorrs

[l o

7l s B

1 usall g clalaadl g cldlal) e diald)

Gl e Gl B85 3 7 sk g duna o a2
. lalaallg

AL AL U el Canll el s "l ALl e
A\EJ}‘A‘}‘M\}‘M‘?‘““—G&L@"MW@“‘J
e Sl vy

Control Panel :

e  This program helps to configure the new
programs, printer, hardware, device drivers,
system information, creating user accounts
etc.

:asadll da gl

¢ paall el 5l J3 e malindl 138 2eley @
3 e ¢ 5eaY) GMlidia agad ¢ Aaglhall Cudi
Gala Gl oLl ¢ gulal) alas e shes
B aadiudly
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e This program can be invoked from the Start
Menu. When clicked the screen looks like
below

J..\Q} "im\ " -'Lé\ﬁ L)‘“ @“UJTJ‘ \M c,LGJ:h-n‘ uSA:‘ °
ALEa L ek ade )

Recycle Bin :

This program is used to store the deleted programs.
In case of restoring the programs to the original
location after deletion can be done using this program

S PYIN A

M_iﬁszMﬁ}M\aw\M@Uﬁd\ \;\Aem" 4
s DA (e ghin my L) Lenb g ) il ey
el 13

Windows Explorer :

This program helps in locating the files and it helps to
organize the files and folders in a computer.
Searching Files, Folders and Pictures:

Windows 7 offers a powerful feature of searching files
and folders.

The program to search can be started from the Start
Menu

M) ol CAESia

bl aalaiy SN ¢ laldll S Jpasll (G el yall 138 2o by
cegulall A& A cilalall

1 osall g clalaal) g cldlall e duad)

il e Gl (BB 5 7 sk g Ayna g 08
L lalaall

LGl el LR Mg Al g

Control Panel :

This program helps to configure the new programs,
printer, hardware, device drivers, system information,
creating user accounts etc.

This program can be invoked from the Start Menu

:?SS\S\Z\AQS
s ¢ saaall zaljll 0153 e zalidl 13a acly
allas e slee 48 yra ¢ 5 gy Cblidia g ¢ dagldall
S padieally ald Clia oL ¢ i gudal)

) " RS e el 138 eledind Sy

Disk Cleanup :

This utility helps to clean up the disk from
unnecessary files

D oAl il

e Glalall e el Cadatt e 3 jaall ol ae b
LA pall

Disk defragmenter:

This utility helps to defragment to avoid uncontigious
allocation of memory. It helps in increasing the better
performance of the system.

e Al by aaad

o2 8l A&l bl aead e s jaall 238 aelid
bJ}J,H.AA}_uaﬂ\gcﬁw\wﬁw|&&\)ﬂ\gauﬂ
. smlall alail Jumdl glaf e ae by
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System Restore :

This utility helps to restore the system to a specified
date incase of malfunctioning

1 G galald) ?LBS ray Balatiul

2la shaay @ pulald) alal a5 salaial e 8 jall o3 2o lid
A 5 alee & Caalall [ seadll et Jal (e gl y3Y)

Windows Media Player :

This application helps to play music in the system

D Jgdligl Baamiall Jail gl b

o AR e sl e Jns e gealiall 138 se Ly

This program helps in performing calculations. Two
versions of the calculator is available namely
Standard and Scientific.

L Pmlad)
Sound Recorder : T gl Javsa el
This program is helpful to record the sound o lebain il pa) Jinai e gealall 134 el
2 pulal)
Calculator :  daudal)

OUS da gy Apbial) Glleall 285 e zeals jll 138 2 luy
s Apalall anst AN 5 Al s Baa) 5 Lanlall e
AP AR

Paint :

This program helps to draw pictures and create
bmp(bit map pictures)

:FLA-HJS‘

.bmp iy

Notepad :

This program helps to type letters and memaos. It is a
word processor package.

: B Sdall

e dmy o5 ¢ Ol SAall g Jilu I AU e zedls Hall 13s 2o by
el y a5 el de sane

Using Help Feature in Windows.

Help feature of Windows helps in getting proper
support and to troubleshoot in case of any difficulty
experienced while using MS Windows.

Help facility can be used by searching for a specific
topic or browse through the topics from the available
category

2 38 oil) Ana s (A MBas Lucall” Apald aladici)

o Jsemal o sels 3815l Auma yr 8 "o Ladl” Auals
o dat il s e 5 1 JSLAAD Jgla s aulia pes
RUPHENEOSY

o Canall YA e Lgaladiinl Sy 0da "sac bl 3 jaa
L Mac Ll M\E@M\ QL:M‘QJE‘)Q}M\
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MS Word gesaill gllea 4

uagall) mllaa A
MS Word Concepts
(4moad) 4adl) ) o> sia)

Alignment : 1 313l
Alignment refers to the position of lines in a Ssa sl o cpad) s ) e sl s 313 Al
paragraph in left, right and center L ddaa
Backspace : : Backspace syl zlida
The [BACKSPACE] key on the keyboard is most oYl Caday iliall da gl e 3 s pall U 13 0 0
ggﬁ]r: used to delete data to the left of the insertion AN 550 @B se (e Jlaal) ) e sy S
Bold : D
Bold characters appear on the screen AU Asls e gale JS8 jedat CajaY) Jasy
Borders : s oalll agaa
Borders are boxes that are placed around text, S aasall o G g€l (il Jaas Bulia (e b e A
pages, and tables Laall Jsaall
Bullets : 1 add Al ciladle
Bullets are special characters or symbols that are Ly bl axdius dals Gooal ol jse) 0 3ke (&
used to set off a paragraph Ll yaal)
Click-and-drag: s 5 AL ) g A
To click-and-drag, press the left mouse button and o) B ~lide e Jaaal 3l il 5 aall gl
keep it down while you move the mouse on the csthaall g sall ) 3, el s o baally il
mouse pad.

Clip Art: s JEY g gual) Ad2Bla
Clip art consists of pre-designed images that can be || (Sa il s Bae Lparaat a3 Al ) geall (po ddadlall oda ) oS53
placed within a document. s ale A leal y
Delete Rows: 1 dighal) i
Use the Delete Rows command on the Table menu Cosha Cadal " gaa A" (e "o ghn (B3 ol axdis
to delete selected rows in a table. Jlanaas a3 Al Jgaall
Double-click: D Al Al
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To double-click; hold the mouse steady while you
press the left mouse twice quickly.

eI dasa) Q5 e 5,0l <l g0 3l L Larall
B e JSy (4 e

Drag-and-drop:

Drag-and-drop is a feature that allows you to move
or copy information. To use it, you simply drag a
selected item from one location to another.

T Y g )

@Mu\;hﬂ\&ﬁ;im&@uﬁsﬂo&
sl A AN & L ad ga (e daaall K s Al
LAY

Exit:

Use the Exit command on the File menu to close all
documents and leave Word entirely.

2 sl

elgi) s Aniall (35l JS (DY Cale AaSY (o yaY) 130 pading
s dasan e Jeall

File Name:

Word assumes that you want to use the first line of
your document as its file name, and places this text
in the File name text box in the Save As dialog box.

¢ Cilal) anad ani

Lol i) Lo 501 30850 (e 01 sl 555 i
qM\HYILbSJMMQMéMUQ‘JA\m

Font:

A font is a style and size of type, such as Times
New Roman, 12 point, bold.

: LAl @ e

Gale g ladll aaa g g 53 Jia badl) <l jae cll 0385 Apaldll oda
Ll Sisall e Gl e

Font Formatting:

Font Formatting changes the appearance of the text.

s hdl) gl

UAJ‘&M\JSJ‘)A&M@M‘M\A dy\;w@k&m
sl

Footer:

A footer is the contents of an area located within the

s calal) Ayl

i | aled) dakaia (s alall ALpS 4SS (231 (g ginall &

A header is the contents of an area located within
the top margin of a page.

bottom margin of a page Aasall
Header: 2 cilal) Aoy s

5 stal Galgll Ailaia 8 alall w5 S 4S5 31 (5 ginall A
i

The Header and Footer toolbar:

The Header and Footer toolbar allows for easy
access to the primary tools for editing headers and
footers.

scdlal) Ay g 5 g ALyl Jay p

ccalall Ay yi g ALy Gpanl At 5 o gal Jay 30 138 (5 5m0

Insert Rows:

With the insertion point within an existing table, use
the Insert Rows command on the Table menu to
create a new row above the current row.

1 dighaa )

O isiaa )3 el DDA e Jsax 3 Gisin 213 (S
sl sxie ady Al Cauall Jiul ol (358 L) Jsan da3Y
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Italic:

Italic characters appear on the screen slightly tilted
to the right

s dile dald

O ) QB pliadly AaLAY o jedas ALl G Y

Line Spacing:

Line spacing refers to the number of lines used by
each line of text. In single-line spacing, each line of
text is followed by another line of text, and there are
no blank lines in between. In double-line spacing,
each line of text is followed by a blank line.

s shad) G cliloal)

Dl aay gl 0 Aliaall ) gandl s ) sllaadl) 3a iy
& A pal sl aady gai sl IS O dus ail) & A
L 13 Lais clagins 38 3 land ()53 o) Y gl

On E U sl Jedand ") shadl ( As 53 e il dpaldy
oalll (B S (g sl U

Menu Bar:

The menu bar contains the names of Word's menus
and is used to navigate through their commands.

Dl g8 oy

€255 Aama (B Al il sl (g Ao sene Jay ) 138 (5 sa
pasalll Lo 3 )55 duma iy el sl 20 LA (e il
Aalisl)

Merge Cells:

Use the Merge Cells command on the Table menu
to combine selected cells in a row. This results in a
single cell with the combined width of the original
cells.

(LAY zan

ST gl aaly Caa 3 LA (e de sanae geal yaY1 138 a3
L da genall AN (i je (5 sy G ya Baa) 5 A

Mouse Pointer:

A mouse pointer is a screen element that
corresponds to the spot where you are rolling the

2 B y&sa

B {E R R JPRN [P PON{ PR TP W e [ER E L ORI EQVY
Al oy gall Daall Bl el JS5 iy S el s

mouse. The mouse pointer can change depending DA e
on the current action.
Normal View: "gle " Las

Normal View is Word's default document view and is
the most practical view for performing such routine
functions as typing, editing, and formatting.

335 e ) (o) BN G el g8 el (g A 138
ua)cd&m‘_‘,ﬁddy\}hjugjﬂcua);"wu}w
Ay paill ety deldall Jie ) algall Caldll

Paragraph:

A paragraph in Word begins where you start typing,
and it ends where you press [ENTER].

: 5_adl)

ey Gl LS 4 1ag Al 18 gall (e Gaill 8558 lag
Enter Jiasy) £l hiai Laxie

Paragraph formatting:

Paragraph formatting includes formatting options
such as text alignment, indents, tabs, margins, and
justification.

15881 (gl

‘UAJ\B\SLMMQQAQAB)E\M)A{X\BAM
Ll ysal) Javia g o gial sed) ¢ Al gaad) ¢ daald) il

Rows:

In a table, a row is a horizontal series of cells.

gl

AEY) LA (40 de pene Jpaall 8 Caall Jiay
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Save as Document:

If you want to use a document again, you should
save it on a disk. When you save a document, you
name it and tell Word where you want to store it.

rdlall Jada

g AT 5 e dalaainy adlisl A Calally Blaay) e i 13)
Jlen (o8 At il daae @B By Gane anly i) Tadas
ulall

Save As:

Use the Save As command on the File menu to
open the Save As dialog box if you want to save the
current document under a new name or store it in a
different folder or disk while also keeping the original
version.

T ply s

sl el 13 Galdll l sl e JIA (e Al Gild) Al
Joaxall J8 Calall L0

Scroll Bar:

The scroll bar is a panel for moving the display
horizontally or vertically within a window.

1ol Jay ydi

ey pail g Lasae ol Ll 4S jat oy Loy pd e B be 5

Shading :

Shading is a Word option that lets you apply varying
degrees of grayness as well as patterns to the
backgrounds of selected text.

gt Al

BN RU VPR PRXSPPR FEORTINE Ny Wi [RCH S FEQER Y
a5l ol s e

Shading color :

Shading color is the percentage or type of shading

il o8l

Use the Spelling and Grammar dialog box to fix
spelling or grammar errors or to add words to the
spelling dictionary.

applied to a selected paragraph, table cell, or frame. ol e e all
Spelling and Grammar: 1Pl g

sl C_\;.aaﬂ L;}zﬂ\ Gl Galdll ) gall e adAiu
iy ALy sl ¢ aill 30 ) sl A el 5 Ay
Aol 3 aatiidl ARD) L sald ) cilallaadl)

Tab:

Tab is the key you press to move the insertion point
to the next indicated tab stop. Word automatically
sets tabs every half inch.

s A gaal)

QLS 550 el pail derdins 3l 5 "Tab" A sl Flide 5o

LR Caal

Underline:

Underlining places a thin line beneath selected text.
It is used primarily for emphasis, but not as often as
bold or italic

D Aai bl

AM\UA\MLLAC.AJJMH&JMQA@LLJ
Gans Jie padinn We (ud (S5 ¢aill 48 (e S o ) Y
Jile Sl sale

Windows Clipboard :

The Windows Clipboard is a holding place in a
computer's memory where data is stored after you
use the Cut or Copy command.

sdual i) jgal g Adabls

o (mpaail) Jainl 5 5l 5 SI3 6 Hal 5813 panas
Leall & sn 0 (S ua ¢ uallly frail) el b Lgalatiiual
(AT e lanant ) Aalal) (50 Ll Lgieal 5 Leau]
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MS Excel

Ayl g AN J glaad) dpaa

Microsoft Excel

45 g S Jgland) daaa 0
RN

3-D Pie Chart

The 3-D pie chart is a simple chart style that is
useful for illustrating the parts of a whole

: olad¥) I (g ilal) daladl

Lall 138 paidg g Aladl sl Ul Jiiadl baylads daad sa
S e B 50 iy

Absolute Address

An absolute address in a formula refers to a specific
cell location or range. It always points to the location
of a specific cell, even if you copy it. Absolute
addresses are created by adding a $ sign in front of
each character in the cell address. For example,
$C$8 always refers to cell C8.

;GM\M‘&JA

JusS) J g (8 gl 50 220 5 i) 0 gie Jididapas e s
Lexa o i D Al age M Leds o3 5l ia Lasa ad) i
008§ Sa )l Aila) JIA e o3l a5 naadl 4 sel) s
Laily jpli $CH8 - DMia ¢ Lagha JS i 5l 2 ganll 5 arall

C asedlly 8 Canall

Active Cell

The active cell contains the insertion point and is
identified by a dark border around the cell. Its
address is shown in the formula bar. Any action you
perform is performed on the active cell.

s Adadil) 4,081

Jsa Bele Ul jeday s Wlla pdisall ladie a8y ) A0a) o
Argall Loyl A lgaa e jedans dasas

Active Window

The active window is the area on the Desktop that is
currently being used and which usually contains a
file or an application.

+ ddadal) 328N

Wl Lo aall 5y () Sl el AL (a6 ad) (oo
Lokt i lila (g sai Llle Al

As New Sheet

Select the As new sheet option in Step 4 of the
Chart Wizard to have Excel create the chart on a
separate chart sheet in the workbook.

B 48,68

Dbl sa 5 Slal) Jagladsl) oLk3) CJL!.A‘_"AL_I\)L\;.“ aaf g8 12a
MJ&MJJQ@M\M\)L@LthJ\} ca\)l\
MM\M\MJJ um&u.n:\lj

Arithmetic Operators

Arithmetic operators are the symbols used in
formulas to calculate values, such as addition (+),
subtraction (-), multiplication (*), division (/), and
exponentiation ().

2 dlaal) jga )
+CAQ\JMMM\M\@L@AM$J\ BYYS P
A ) 5 / Al g * G puall g - 2 hall

If you want to perform a function quickly without
inserting it into a worksheet, you can use Auto
Calculate on the status bar. Simply select the
function you want to perform, and then select the
range you want to perform it on.

" el aladil Sy pilie g e e S Al Alls 35 < )l 13)

Dbl elldg Aoma pully (alall Alal) jlass (e ™ (A Cilias
lebiea 3l el dlae Y1 Jlaa s ¢ Lok ol ) A1)
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AutoCorrect:

AutoCorrect is an Excel feature that automatically
corrects a variety of commonly misspelled words. It
also lets you create "shorthand" entries that
automatically fill in frequently used text when only a

eladY) oty Ll o 685 3 5 Q) Ol Jae (30 8 e (A
e AR & 5 Al Gaill HLEAT (e SliSat g ¢ AL ALY
oalll e Y1 i alY delids vie Ll yelas iMA e Al

few letters are Jaaddl
entered.
AutoFill Luilaly Aty

AutoFill is the Excel feature that allows you to
automatically copy cells and fill them with a series
without using Copy.

SN Aalall 5o Lilali Leaius g LAY Rty ducalal) oda 1€
LGalll 5 el el aladind

AutoFilter

AutoFilter mode lets you quickly display only the
rows in a list of data that meet the criteria that you
specify. Unlike data form mode, you can see all the
matching records at the same time as they appear

B 3\.}.‘1&&3\ M". wi|]

ULl o (e Castiall Jadd lel) e dualdd) oda SIS
bl e o 10 5 A da g i L (30 )5 Lgrpen
ol (& Cshuall JS A5 5 el e (A galall UL i pe

on the list. choall o LS il
AutoFormat ¢ (AL g

The AutoFormat command applies predefined styles
to worksheets or selected ranges of cells.

JS o e 3aaa il Gulat aukaind 5 Y1 A e

Average

Provides the average of the range of references in
the argument.

H {.\@J‘Y‘ d.h.A

a1 138 JBA (ge B30 LA 8 a8, Y) Jane s ki

Borders

Borders are line effects that you can place around
cells or cell ranges to improve the appearance or
effectiveness of your worksheets.

s LA agas

O Cma 52 ) WAL ddapaall L shadll e ol il o
anll 285 8 LAY o3 eda 3l ol cpent i) (e LR

Calculated Field

A calculated field is a field in a database that
contains a formula. Bradi¢ Yzs sales worksheets
already contain one calculated field, which appears

: ggLuﬂ\ Jaall

tw\dw‘éj)@.ﬁ:\\h\) Lub»;ﬂsag;;ﬁ'&)\;t"_\wb

in the Total column. RES
Cell R

A cell is the intersection of a row and a column. A
cell can contain a label, a numeric value, or a
formula.

A o e e Al (5 5int o (S, 3 gee pe i oblis »

Cell Address

A cell address is the location of a cell on a
worksheet and is defined by the column letter and
the row number. For example, cell Al is where

s 448 ol gie

Janll 48 ) 5 (8 AR 28 gl Ja g oA AN aa je e 3l oo
Olsie & AL Dldd Caall 8 )53 geall Jaysnaad oy (2
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column A and row 1 intersect.

1 aally A dsenll b asi s

Cell References

A cell reference, or cell address, identifies a
particular cell, such as cell B5. Cell references are
used in formulas to indicate where a value is stored.

s 4 s se

b LAY aal je podins | BE ARl Jia 8adse AlA a8 ga dany
653 ) LAY ad e ) 5 5L Apluall CYaleall a0
Aabuadl Cllend) o3 A daddinudl ol )Y)

Charts

Charts are graphic presentations of data from a
worksheet.

Al cillbia

anll 855 8 A2l ULl Sl ane )l cilahie 8

Columns

Columns are the vertical divisions of a worksheet
that are identified by letters.

. baacy)

DA (e i A5 Jand) 38 ) 5 (g0 43 gl ) 321 o
B

Count

Returns a count of the number of items in the range
in the argument.

sl ae qlaa

LA (e 23ma (530 8 sall aae a1 138 IS (e s
Al LAY s b Jay Y

Currency Format

The currency format places dollar signs and comma
separators in numeric entries. Negative currency
values are displayed in parentheses

;M\M

o YY) ALali g Y ol dlee (il \ 138 A e g
s O el L) lac Y1 A )l edlaaall

Data Form

A Data form is an easier method of viewing, editing
or entering information for each record. The form
has text boxes for each of the fields in the
databases, and the records appear one at a time for
your examination and editing

s il el Jaai

38 s me . s JEV A i) i s e 58
)@.}:\3} ikl SMG@M\@ ds;dﬁ:gaadgéhm.haﬂ
4;.“&‘\“‘5 d\;dy\.‘ 3aal g 3y M) oda

Data Range

The data range is the area of the worksheet that you
want to chart. It includes any numeric data that you
want to chart and can include the titles for the data.

. Clul,‘\,\.“ $a

L 35 ) el s 531 el 355 50 e 5ol 0
Q_IL\L\J\ oda U:\}Ltc éjﬁ}%)&b@dié}&@)@@

Dollar Sign ($)

In addition to indicating a currency value, a dollar
sign designates an absolute cell address in an Excel
formula.

1§ ¥ 5L

Loyl Jiad 5 LEY) o8 (8 ¢ Y gall Aadle Jias Ll ) ddlaYl
S 8 Aplaad) Glleal) o) ja) L dallaall LAY e

Fill Handle

The fill handle is a black symbol in the lower right
corner of the active cell. Clicking-and-dragging the
fill handle can copy cell contents or create a series.

2 Ay gl dias)

ARSI EN | A g W P YU IR P S ST
Al eli] ol 208 o3 (5 gine foui Sy S Ll o34
Gl 5 3l 138 e dazaall JNA e B ey o dadae
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Lot ol yall LAY dles ) ) ey

Fill Pointer

The mouse pointer becomes a fill pointer when it is
positioned over the fill handle of the active cell,
indicating that it is in the correct position to click-and-
drag it.

: Aatl) dise

Gsa sl Ldige gy ie 4] juea s3I h5e JSE s
] maall a8 sall 3L g salll el 3a
Aol Ll Jal e 8

Formatting

Formatting is the attributes of a cell that affect its
appearance. Cell formatting does not affect its
contents, only its on-screen appearance.

” )

o

OSV s selie (o sl LOIAN e Ly g5 3l (ailmtl
1 sekha e i L s Lol siaa e g0 Y ol oa

Formula

A formula is an expression entered in a cell that
performs numeric calculation, logical comparison, or
text string manipulation.

: ;\,.\.éh..)l\ 2\&.).431

A Clalea gl ) il i

Formula Bar

The formula bar is located under the toolbars at the
top of the working screen. It contains the edit line for
working with formulas, and provides information
regarding cell addresses.

s ddpuall bay

Gsnas Jandl 48 )5 el dune ll da il Jauf Jay il 13 a8y
Alelal) LAY

Functions

A function is a preset formula. Functions consist of
the function name and its arguments. The function
name tells Excel what calculation you want it to
perform.

¢ gy 1 1 s

M\ﬂ\y‘é;ﬂ@ﬂ\&mﬁm@mw@
Apluall dleall & 53 Jus) dpna yl asy Allall sl 5 LeSlaasa g
Jadadn o) )

Min

Returns the smallest value in the range in the
argument

- T il AN

.QM\C}AAAMLSM‘;WJE‘L._\HA:

Mixed Addresses

Mixed addresses are cell references that combine
absolute and relative addressing, making either the
row or the column absolute. Following are examples
of mixed addresses: $A1,E$15,$C3. $A1 refers to
an exact column, A, but leaves the row as a relative
address.

. Adalidal) LAY o glis

e (A A g Adllae LA aal je g sad Al LIAT aal je o
Do Y 3 el ol Caall i ye Jea LA (e Sl 5 8 1)
. $C3 «E$15 ¢ $AL : elld o Jlie Jail o seoll ol
Laiw il A dseall ) iy AT Lalisall aa yall o Cas
) peill 3aadl a8 gl s Caall aa e iy

Operators

Operators are used to tell Excel what mathematical
functions to perform in a formula. The following
symbols are the operators which are used most
often in Excel formulas: Addition (+) Subtraction (-)
Multiplication (*) and Division (/).

sdglaal) ga )

Al yal) dnliall Qw\wéiépﬂ‘iﬂ)ﬁj\ T PREL ]
/Al ¢ * G uall ¢ _C)H\‘+¢A;J\;d~£]

Paste Function

: A Gl
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Paste Function is a feature that guides you through
all of the steps using the Paste Function Dialog Box
and the Formula Palette.

En bl shall e de gana 285 JUA (e Lgediind B j0e 2
Bl S5 a2 3y i 3 ANl aaas Jaf e il
sl Glsall & gaall Al

Range

A range is a block of cells that can be selected,
manipulated, named, or formatted as a group.

: LAY s

Sl Lbaani (S LS Lgtiadlaa sl lauas o LA (e de sana
Bl g de ganaS il fine Gl

Range Address

A range address identifies a range by the cells
located at diagonally opposed corners. For example,
F3:G59 identifies a range that starts in cell F3 at the
upper left and extends through cell G59.

s LAY s ol sie

) 138 (e Hadl ) LAY gaan ol siall 138 OO e sms
e Al 5l LAY (50 2083 F3 1 G5O : DMie (5 sna JSn
L GB9 Al iy s e yslall Ayl ) L5 F sl

Range References

A range reference, such as C3:G76, identifies a set

of cells as part of a formula in Excel. An easy way to
create a range reference is to drag-select the range

while you are editing the formula.

:L})\.ﬂ\du&)ﬂ

dageal) (5o 6 528 LA 520 2any C31 G76 e g sall 138
LAY (e saal an all 130 cLISY 5 Ju) 8 Aeadiunall Al
JBJ;\ ;.Lui L;.\AM gy\;@mécc‘)u\mu%m)ejm
Abeal) depall

Relative Addresses

A relative address is a standard cell reference that
appears like this: A1,E15,M42. A relative address
changes if you copy a formula that contains it to a
new location on the worksheet. Think of it like saying
"in two weeks" - the date will always be different (or
relative) depending on the current date.

s ddl) (o glintf

E15 ¢ AL : Jie JuS) 8 axdiual oual 581 LAY a0 5
FEIN | QY;M\@&.\A;I:\SGE&)A\ ety M42 ¢
oS DAL 138 405 (s Joddl 155 0o 20 gige b
£V 138 8o o) o )5 ) A a8 g gl 8 Gae s

Rows

Rows are the horizontal divisions of a worksheet that
are identified by numbers.

: gl

AV IR (e ipaly Janll 4855 AAEY) o1 5aY) (oo

Row-Select

Use row-select to select the entire range of cells in a
row by clicking the row header.

s il JLaal

o) e S OYA e le a8 DA aes s Sy
caalll

Sheet Tabs

Sheet tabs contain the names of the worksheets in a
workbook at the bottom of the working screen. You
can click the sheet tabs to show their corresponding
worksheets.

:M\db}iéw

W) Cale 35 s sall Jamdl (31 ) 51 Lo Cilpansall 038 (5 523
22 G gl o Ll ey Janll 3855 23S il & ek
L) Dliall Jaad) 48 ) 5 sl JlelaY Claandl)

Spreadsheet

Spreadsheet is the generic term for applications,
such as Excel, that you can use to enter, analyze,
and calculate data. It performs mathematical
calculations and projections based on data entered.
Common spreadsheet uses include analysis,

sdgbaal) Jaadl (31

(JuS) Lpnaey Jie Jandl (31 ) 5 lipat] aodivsall alall ausll s
Clidatl) o3 o s bl Clua s Jalat s JASY adding Cus
Aliad) bl e Gl g jliall 5 gl ) clibuall o) ol
) sl ¢ Jilaill aasis ale J Anbual) Jasdl G, 51 )

charting, and budgeting. A el Sl 5
Sum : ) Adee
Adds the values in the function argument or the
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values in the cell references in the argument

o e 3l ) A2 G K (yarn LR 2y 1 2ae ) e
ANl e (e laaani &3 i) LA

Values

When a cell contains a formula, the resulting number
shown on the screen is called a value.

FIEV/ PV

gl Y alaall o8 dais (8 dplea ¥ alea LA szm Ladic
A and A4S e jelad

Workbook

A workbook is the Excel file that stores your
information. Each workbook may contain numerous
worksheets.

2 Juus) s

05 g lelin 5 ) ) K a3 Ju] i o
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Worksheet

A worksheet is an electronic spreadsheet that lets
you enter, analyze, and calculate data. Within a
workbook, worksheets can share information, and
calculations pertaining to several worksheets can be
performed at one time.
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Wrap Text

Wrap Text is a cell formatting option that forces text
to break into lines within a cell.
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MS PowerPoint

il G2 ) e

PowerPoint Concepts
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PowerPoint:

An application program to create presentations.
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ERIg NP REENRICR-E WO

Slide :

Each sheet in a PowerPoint file
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Views in PowerPoint :

1 g g A B Gl Jsai

e Normal view gdall i g2ll @

e Slide Sorter View . A 56 e

e  Slide show view 0l

. il pae e
Slide Layout : s dag pall Jaudads

e Text layout Ginall hhis e

e Text and picture layout s Py Ll e

e Organization chart layout = }M“ ] "] ..

e Table layout =TT *

e Chart layout etc. Jsia lphadi o
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Slide Design : D day )& asanal

e Picture or some color background applied to
slides in PowerPoint
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Animation Schemes & Slide transition :

o Effects applied to slides and text during slide
show.
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File extension of MS PowerPoint :

e The file extension of MS PowerPoint is .ppt

:C\-H._,‘”JJQ calal a)aiaY) (.v.ﬂ\

ppt & Jaie¥ aul

Slide show features :

sl (B e @

¢ Rehearse timings Gl e cpyad e
e  Set up show ) a yall ;\x_\
e Slide show " ua._ '
Ayl e
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Windows Movie Maker (Animation)
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Windows Movie Maker Concepts
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Windows Movie Maker :

An application program to create animations.

S9N Gl
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Frame :

Each slide in the animation program

T Aag,dd)
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Transition in Animation :
¢ Image transition
e Text transition
o Image effects

rh g g A B Gl Jsai
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is a collection of data that is organized and meaningful.

a) Input Device.
1 b) Information.
c) Out Device

d) Figures

CPU full form is

a) Central Processing Unit.
2 b) Control Processing Unit.
c) Control Product Unit.

d) Central Processing Unit.

Keyboard is an device.
a) Out.

3 b) Storage

c) Input

d) Memory

RAM is also known as

a) Temporary Memory.
4 b) Permanent Memory.
c) Storage Memory.

d) Input Memory.

1024 KB is

a) 1KB
S b) 1MB
c) 1GB
d 1TB

Spring Semester 2010/2011
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Which of the following is a Internet search engine

PROLOG
e Java
Google

=
[ ]

Gmail

Which could be the website of Dhofar University based on the standard
naming conventions for the websites

www.du.edu.om
www.du.aero
www.du.gov.om
www.du.com.om

1) Create a folder on the desktop.

2) Open the folder

3) Create four sub folders with the names IT, English, Math’s, Arabic

4) Open IT Folder

5) Create two Microsoft word document and name them as First.doc and
second.doc

6) Cut second.doc and paste it in English folder

7) Rename the Math’s folder as Mathematics folder

8) Create shortcut for IT folder in the desktop
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1) Type the following passage in MS Word
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ALROSOFT NN

Using the Desktop to Open Word

There are three ways to open Word directly from the Windows desktop. Your computer may not offer all

of these options, but you can use at least one of them:

e Click the Word icon on the Office toolbar.

2) Do the following on the above document created

—>Type the following in MS Excel worksheet

e Add page numbers to the document

e Add "Document 4" in header and "Home Work" in footer

Oman Oil Sales Statistics

Months Total N .
Sales Average | Minimum | Maximum
Region January | February | March (Region) | Sales. (Region) | (Region)
Muscat 98767 76548 52329
Dhofar 86229 98237 72390
Musandam 92729 82301 72398

1) Add colors to every columns of your choice

2) Change text color to Blue for “ Total and Average”

3) Format the numbers with three decimal places

4) Find Total Sales(Region) for Muscat by relative reference

5) Draw a pie chart for Muscat Region

6) Format the plot area, chart area and legend for the above chart
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7) Filter the data to display only the information of Dhofar region

1. Open a new powerpoint file

2. Create a five to seven slides on the Topic “Evils of Smoking” (Choose
the Layout and the contents of the slides as per your choice)

Save the powerpoint file as second.ppt in desktop

> w

Apply “Slide Design” of your choice for each of the slides

Apply “Animation Schemes” of your choice for each of the slides
Adjust “ Setup Show” for the above created slides

Insert Date and Time in the slide master

Insert Slide Numbers in the slides.

© ® N o O

Duplicate slide 5

1. Open the program Windows Movie Maker.

2. Create a simple animation of your choice,

3. Apply text effects to the animation created,

4. Apply image transition to the animation created,

5. Apply image effect to the animation created.
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